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Chapter 1. Introduction 
 

BT Inbound Contact global delivers comprehensive reports to help the customer optimise their global call 

centre operations. Traffic data captured includes when calls come into each centre, when they are 

blocked and why. Armed with this information, the customer can quickly monitor their inbound network 

performance and respond by increasing staff, adding lines or re-routing calls to maximise efficiency.  

Reporter cannot be used to verify Billing.  There are a number factors the support this position:   

- The key reason is the difference data sources used for the Billing feed and the Traffic feed.     
- CDRs can go to error suspense, for example if a tariff is missing. Or CDR and SDR can be 

delivered to their respective platform in different timeframes.  This will result in calls appearing 
in Billing later than Reporter.      

- If a customer uses NOAS mid-call announcements or NOAS menu routing, these don’t 
produce separate SDRs.  However customers will see them as separate calls on the invoice.   

 

Call Traffic Reporter (Reporter) can be delivered via the Internet in either English or German. If other 

languages are selected, some administrative information maybe presented in that language but most 

information will be in English.  

Reports cover an entire organisation and can be broken down by individual call centre and inbound 

number application. Individual reports can be distributed to locations throughout a company, allowing 

each centre to manage its own operation.  

Statistics are compiled by: 

• Call by call detail 

• Hour or date 

• Originating Detail (country of origin, access number, etc.) 

• Inbound number (Application ID)  

• Service location/termination  
  

Reporter offers the following report types, delivery options and availability: 

 

Report Type Delivery Options Availability 

Summary, Daily 

and Monthly 

Internet/Download Next Business Day  

Call Detail Internet/Download Same Day 
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Standard Reports 

Reporter includes 4 standard statistical reports that break down data by Corp Id, Access Number, and 

Origination combinations. The reports include detailed information broken down by hour, and day for: 

• Call attempts 

• Call completions 

• Call duration 

• Call abandonments 

• Calls released 
 

Call information is stored for up to 180 days for Daily Summary Reports and up to 12 months for Monthly 

Summary Reports for customer access. 

Call Detail Reports 

The Call Detail Report is a report that provides detailed information on every call, giving the customer 

vital information to help maximize inbound service call completions.  This report supplies visibility into all 

of the customer’s incoming calls. The report can be viewed online and/or downloaded to the users PC. 

The Call Detail Report provides the ability to view call detail on a 7x24 basis.  

Call information is stored for up to 90 days for Call Detail Reports. 

Internet Access 
 

In order to give customers greater access to their BT Inbound Contact global application, BT has 

developed the ability to view Reporter information via GS Portal.  Customer information is protected 

through the use of firewall technology and customers are required to utilize a username/password in 

order to access their information. 

Logging On 
 

Internal users may be added to the Reporter, by completing the "Call Traffic Reporter (Reporter) Data 

Capture Form." Customers will need to ask their account team to get them access. 

Once the processing is complete, an email will be sent with the User Id and Password along with the link 

to access reports. 
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To log on, use the following URL https://www.globalservices.bt.com/uk/en/my_account and enter the 

user id and password. 

 

 

Enter Pin and click “Authenticate”.   
  

  

   

https://www.globalservices.bt.com/uk/en/my_account
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Getting Help or Issues with the Internet Browser 
 

Internal users may open trouble tickets against Reporter with the BT Service Desk.  

If you are having problems accessing Reporter, please follow the below steps to clear the cache in 

Internet Explorer browser. Sometimes ctrl+F5 which clears the cache and refresh the browser may not 

properly work in IE, instead you can clear the cache in other way.  

The below steps are for IE9 and may be same for below versions as well. 

1. Go to Menu > Tools > Developer Tools   (or)  click F12 
This option is available when we open a new browser only and this will not be available for other 

tabs in the browser.  

2. Now, we can see the below option and go to cache and click on clear browser cache. It takes 
some time to clear the cache.   

 

 

3. When it completes the action then access VLP by typing or paste the URL in the browser instead 
from browser favorites. 

If you are using IE11, please make the following changes in compatibility view settings.  

Please go to IE 11 > tools > Compatibility View settings:-  

bt.com should be added to compatibility view and checkbox ‘display intranet site in compatibility view’ 

should be ticked. 
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Welcome Screen  
 

The welcome screen contains the applications. 

 

 

• Click on the View Applications, then click on Enterprise Reporting – Launch Application from 

the list on the page.  
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Business Intelligence Landing Page  
 

The Dashboard Screen can be used to make changes to a user account such as date format or 

language.  

 

 

• Select Dashboard from the top of the screen, then select Inbound Contact from the drop down 
menu. 
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My Account Screen  
 

The My Account Screen can be used to make changes to a user account such as date format or 

language. Click on drop down arrow next to your user id. Then click on My Account. 
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• Select User Interface Language to change the language from English. Full language conversion is 
available for German. Other languages are available for the data fields. 

• Select Time Zone to change date format. The default is MM/DD/YYYY. For example, if the time zone 
is changed to Greenwich Mean Time Dublin, Edinburgh, London, the date format will change to 
DD/MM/YYYY. 

• To complete this change, Click on OK at the bottom of the screen. 
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List of Reports and Sort Feature on Reports 
 

List of Reports 

This screen shows the list of the reports. Simply click on the report to be viewed. The screen is also used 

to flash message across the screen to notify users of any updates to the system. 
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Sort Feature on Reports 

 
There is a sort feature on the columns. On the screen capture below for Orig Country, you can in sort 
ascending/descending order making information easier to find. At the bottom of the screen you also 
have the ability to export the information to an excel spreadsheet and sort the data using the features 
in excel. 
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Chapter 2. Comprehensive Summary Daily 

Section 1. Report Description 

 

The report provides  

 

• a daily breakdown by access number.   

• a feel for the distribution of traffic over all access lines to a site on an daily basis. 

Section 2. Notes/Assumptions 

 

• the report includes all originating and terminating countries. 

• the report includes all completed and failed calls. 

• the report will consist of details for the selected access number and time frame. 

• the report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen    

          

 

• The user must select the Corp ID and click on Apply before selecting the Access number. 
  
Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The access number is the number dialed by the caller. All caller 

access numbers are linked to an Application Id.   

Note: The user must select the Corp ID and hit Apply before they 

can select the Access number.  

Date  

Between  

Select the date or date range to be retrieved. 

The date of the beginning and end of the call.  
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Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. Then click on Apply. 

The hour of the beginning and end of the call.   

Note: The default is 0 to 23 GMT Hours and 0 to 59 Minutes. 
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Output Screen 
 

 

 

 

Output Field- graph Description 

Y axis The number of calls.  

X axis The date and hour of the calls 

Bar The bars are color coded to separate Completed, Released, and 
Not Completed calls.  Move the cursor over a section of the bar to 
see the number calls.  Click on the bar to display the report for that 
specific section of the bar graph.   
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Output Field- table Description 

Date The date of the call. (Format: DD/MMM/YYYY) 

Hour The hour of the call. 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

 

Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned,Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Origination 

Country  

Name of country associated with originating country code. 

Orig Code Country code associated with the dialed access number (see 

Appendix A for a complete list of country codes). 
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Access Number The number dialed by the caller (not necessarily the same as the Network 
Address). All caller access numbers are linked to an Application Id.   

 

Access Type Inbound access type. 

DomTF Domestic Tollfree 

ITFS International Tollfree 

UIFN Universal International Freephone Number 

PSTN Public Switched Telephone Network/Caller Pays 

SC Shared Cost 

NCR National Call Rate 

IVRP/ 

Redirect Interactive Voice Response/Redirect 

DTF Direct Tollfree 

PRS Premium Rate Service  

TIVRP Transfer Interactive Voice Response, 2nd leg 

 

App ID  Application Identifier. (corresponds to the dialed number). Applications Ids 
are a grouping of one or more BT Inbound Contact global access 
numbers.  All access numbers must be linked to a 10-digit application Id.  
They are assigned from within the Logical Provisioning System. For 
reporting applications, Application Ids provide a way to break out specific 
applications and view how well they’re performing. 

Network Address Network address where call enters BT network. 

This is typically the called party number received by the BT network. 

It may be displayed in various formats. 

Term Type Termination Type  

• Swi = Switched Destination Number  

• Ded = Dedicated Destination Switch/Trunk ID 
Note: Termination Types are only applicable to certain networks. 

This field may be blank (typically it is blank for domestic BT Inbound 

Contact). 

Term Country Country of Termination 

Note: the Term Country is function of the Term Type, when there is 

no Term Type displayed, there is no Term Country displayed either 

Term Code Terminating country code (see Appendix A for a complete list of 

country codes). 
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Note: the Term Code is function of the Term Type, when there is no 

Term Type displayed, there is no Term Code displayed either 

Svc Loc Id Service Location Identifier (customer label for termination) The Service 
location represents a switched or dedicated termination registered to a 
specific customer Corp Id.   

 

The Service location is used in logical provisioning, when defining 

routing plans and terminating features.  All service locations, will 

have user-friendly names or ‘labels” that are registered in order 

entry. 

Destination Terminating number (phone number or Switch/Trunk/DNIS digits) 

DNIS Digits Dialled Number Identification Service. DNIS is only used by customers on 
the Global network with dedicated endpoints. This field includes the 
outpulsed DNIS digits. DNIS manages calls more efficiently so that when 
the customer advertises a specific phone number for a special promotion, 
any calls generated can be directed to a particular agent within the contact 
centre. 

 

DNIS allows customers to specify which digits are delivered to a 

Dedicated Access Line (DAL), based on a number of factors. The 

customer’s ACD/PBX uses the digits to manage calls more 

efficiently. For example, if a customer advertises in several 

countries, DNIS can ensure that a call is answered at the correct 

language queue. Or if a customer advertises a specific phone 

number for a special promotion, this feature can direct calls 

generated to a specific agent within the termination call centre.  

DNIS supports 1 to 15 digits 

Calls  Number of calls during the specified time period. 

Minutes  The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 3. Comprehensive Summary Monthly 

Section 1. Report Description 

 

The report provides  

 

• a monthly breakdown by access number. 

• a feel for the distribution of traffic over all access lines to a site on an monthly basis. 

Section 2. Notes/Assumptions 

 

• the report includes all originating and terminating country. 

• the report includes all completed and failed calls. 

• the report will consist of details for the access number and timeframe 

• the report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen  

 

  

 

• The user must select the Corp ID and click on Apply before selecting the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.  The caller access number must be 

recorded on the billing record.   

Note: The user must select the Corp ID and hit Go before they can 

select the Access number.  

Date  Select the date to be retrieved. 
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Between  The date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. 

The hour of the beginning and end of the call.  
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Output Screen 

 

 

Output Field - 

graph 

Description 

Y axis The number of calls.  

X axis The day of the calls 

Bar The bars are color coded to separate Completed, Released, and 
Not Completed calls.  Move the cursor over a section of the bar to 
see the number calls.  Click on the bar to display the report for that 
specific section of the bar graph.   
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Output Field- table Description 

Month The month of the call. 

Date The date of the call. (Format: DD/MMM/YYYY) 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

 

Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned,Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Origination 

Country  

Name of country associated with originating country code. 

Orig Code Country code associated with the dialed access number (see 

Appendix A for a complete list of country codes).  
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Access Number The number dialed by the caller (not necessarily the same as the Network 
Address. All caller access numbers are linked to an Application Id.   

 

Access Type Call status on release (answered, busy, abandoned, etc.) 

DomTF Domestic Tollfree 

ITFS International Tollfree 

UIFN Universal International Freephone Number 

PSTN Public Switched Telephone Network/Caller Pays 

SC Shared Cost 

NCR National Call Rate 

IVRP/ 

Redirect Interactive Voice Response/Redirect 

DTF Direct Tollfree 

PRS Premium Rate Service  

TIVRP Transfer Interactive Voice Response 
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App ID  Application Identifier. (corresponds to the dialed number). 

Applications Ids are a grouping of one or more BT Inbound Contact 

global access numbers.  All access numbers must be linked to a 10 

digit application Id.  They are assigned from within the Logical 

Provisioning System. For reporting applications, Application Ids 

provide a way to break out specific applications and view how well 

they’re performing. 

Network Address Network address where call enters BT network. 

This is typically the called party number received by the BT 

network. It may be displayed in various formats. 

Term Type Termination Type  

• Swi = Switched Destination Number  

• Ded = Dedicated Destination Switch/Trunk ID 
Note: Termination Types are only applicable to certain networks. 

This field may be blank (typically it is blank for domestic BT Inbound 

Contact). 

Term Country Country of Termination 

Note: the Term Country is function of the Term Type, when there is 

no Term Type displayed, there is no Term Country displayed either 

Term Code Terminating country code (see Appendix A for a complete list of 

country codes). 

Note: the Term Code is function of the Term Type, when there is no 

Term Type displayed, there is no Term Code displayed either 

Svc Loc Id Service Location Identifier (customer label for termination) The Service 
location represents a switched or dedicated termination registered to a 
specific customer Corp Id.   

 

The Service location is used in logical provisioning, when defining 

routing plans and terminating features.  All service locations, will 

have user-friendly names or ‘labels” that are registered in order 

entry. 

Destination Terminating number (phone number or Switch/Trunk/DNIS digits) 

DNIS Digits Dialled Number Identification Service. DNIS is only used by 

customers on the Global network with dedicated endpoints. This 

field includes the outpulsed DNIS digits.  DNIS allows customers to 

specify which digits are delivered to a Dedicated Access Line 

(DAL), based on a number of factors.  

Calls  Number of calls during the specified time period. 
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Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 4. Corporate Summary Daily  

Section 1. Report Description 

 

This report summarizes calls in each call status on a hourly basis by Corp Id. 

 

Complete Call Delivered 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released 

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Section 2. Notes/Assumptions 

• report contains number of calls for each call status. 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen             

 

 

• Select the Corp ID, Dates, Hours and Minutes and click on Apply to generate the report. 

Input Field Description 

Corp ID  Select the Corp ID to be retrieved. 
Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

Date  

Between  

Select the date to be retrieved. 

The recorded date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. 

The recorded hour of the beginning and end of the call.  

Note: The default is 0 to 23 GMT Hours and 0 to 59 Minutes. 
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Output Screen 

 

 

Output Field - 

graph 

Description 

Y axis The number of calls.  

X axis The date and hour of the calls 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Date The date of the call. (Format: DD/MMM/YYYY) 

Hour The hour of the call. 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

 

Call Result Call status on release. 

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Calls Number of calls during the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 5. Corporate Summary Monthly  
 

Section 1. Report Description 

 

This report summarizes of calls in each call status on a daily basis by Corp Id. 

  

Complete Call Delivered  

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Section 2. Notes/Assumptions 

• report contains number of calls for each call status. 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen  

 

 

• Select the Corp ID, and Dates and click on Apply to generate the report. 

 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Date  

Between  

Select the date to be retrieved. 

The recorded date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 
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Output Screen 

 

 

Output Field - 

graph 

Description 

Y axis The number of calls.  

X axis The date of the calls 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Month The month of the call. 

Date The date of the call. (Format: DD/MMM/YYYY) 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

 

Call Result Call status on release (answered, busy, abandoned, etc.) 

Complete Call Delivered  

Not Answered 

Includes Call Abandoned,Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Calls  Number of calls during the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 6. Access Number Summary Daily  

Section 1. Report Description 

 

The report lists the number of calls by access number and call status on a daily basis. 

Section 2. Notes/Assumptions 

• report includes call status. 

• report includes Origination Country and Origination Country Code. 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 

 

  
  



 

38 
 

Input Screen  

 

  

• The user must select the Corp ID and click on Apply before selecting the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.  The caller access number must be 

recorded on the billing record.   

Note: The user must select the Corp ID and hit Go before they can 

select the Access number.  

Date  

Between  

Select the date to be retrieved. 

The recorded date of the beginning and end of the call.  
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Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. 

The recorded hour of the beginning and end of the call.  

Note: The default is 0 to 23 GMT Hours and 0 to 59 Minutes. 
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Output Screen 

 

 
 

Output Field – 

graph 

Description 

Y axis The number of calls.  

X axis The date and hour of the calls 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Date The date of the call. (Format: DD/MMM/YYYY) 

Hours The hour of the call. 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

 

Origination 

Country  

Name of country associated with originating country code. 

Orig Code Country code associated with the dialed access number (see 

Appendix A for a complete list of country codes. 

Access Number The number dialed by the caller (not necessarily the same as the 

Network Address). All caller access numbers are linked to an 

Application Id.   

Access Type Inbound access type. 

DomTF Domestic Tollfree 

ITFS International Tollfree 

UIFN Universal International Freephone Number 
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PSTN Public Switched Telephone Network/Caller Pays 

SC Shared Cost 

NCR National Call Rate 

IVRP/ 

Redirect Interactive Voice Response 

DTF Direct Tollfree 

PRS Premium Rate Service  

TIVRP Transfer Interactive Voice Response 

 

App ID  Application Identifier. (corresponds to the dialed number). Applications 
Ids are a grouping of one or more BT Inbound Contact global access 
numbers.  All access numbers must be linked to a 10 digit application Id.  
. They are assigned from within the Logical Provisioning System. For 
reporting applications, Application Ids provide a way to break out specific 
applications and view how well they’re performing. 

 

Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

 

Calls Number of calls during the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 7. Access Number Summary Monthly  

Section 1. Report Description 

 

The report lists the number of calls by access number and call status on a daily basis. 

Section 2. Notes/Assumptions 

 

• report includes call status. 

• report includes Origination Country and Origination Country Code. 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen  

 

  

• The user must select the Corp ID and click on Apply before selecting the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.  The caller access number must be 

recorded on the billing record.   

Date  

Between  

Select the date to be retrieved. 

The recorded date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 
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Output Screen 

 

 

Output Field Description 

Y axis The number of calls.  

X axis The date of the calls 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Month The recorded month of the beginning of the call. 

Date The date of the call. (Format: DD/MMM/YYYY) 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

Origination 

Country  

Name of country associated with originating country code. 

Orig Code Country code associated with the dialed access number (see 

Appendix A for complete list of country codes) 

Access Number The number dialed by the caller (not necessarily the same as the 

Network Address). All caller access numbers are linked to an 

Application Id.   

Access Type Inbound access type. 

DomTF Domestic Tollfree 

ITFS International Tollfree 

UIFN Universal International Freephone Number 

PSTN Public Switched Telephone Network/Caller Pays 
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SC Shared Cost 

NCR National Call Rate 

IVRP/ 

Redirect Interactive Voice Response/Redirect 

DTF Direct Tollfree 

PRS Premium Rate Service  

TIVRP Transfer Interactive Voice Response 

 

App ID  Application Identifier. (corresponds to the dialed number). 

Applications Ids are a grouping of one or more BT Inbound Contact 

global access numbers.  All access numbers must be linked to a 

10 digit application Id.  . They are assigned from within the Logical 

Provisioning System. For reporting applications, Application Ids 

provide a way to break out specific applications and view how well 

they’re performing.  

Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 

  

Calls  Number of calls during the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 8. Destination Summary Daily  

Section 1. Report Description 

 

The report lists the call results by hour for a Corp Id and Destination.   

Section 2. Notes/Assumptions 

• report includes call status. 

• report includes total number of calls and minutes. 

• graph contains only completed calls. 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 

 

Note: For optimum display of Destination graphs, select a single access number or a limited time period 

for multiple access numbers. The graph may not display properly. 

 

If the graph area is displayed with an explanation point (!), there are too many data points for proper 

display, however the graph may still be downloaded into a spreadsheet program for viewing and all of 

the data will still be included in the Data Table below the graph. 
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Input Screen  

 

 

 

• The user must select the Corp ID and click on Apply before selecting the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.  The caller access number must be 

recorded on the billing record.   

Note: The user must select the Corp ID and hit Go before they can 

select the Access number.  

Date  Select the date to be retrieved. 
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Between  The recorded date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. 

The recorded hour of the beginning and end of the call.  

Note: The default is 0 to 23 GMT Hours and 0 to 59 Minutes. 
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Output Screen 

 

 

Output Field – 

graph 

Description 

Y axis The number of calls.  

X axis The destination of the calls. 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Date The date of the call. (Format: DD/MMM/YYYY) 

Hours The hour of the call.  

Corp ID  Customer Corporate Identifier. The customer Corporate ID 
establishes service for a customer Corp ID is an 8-digit. The 
Corporate Id is the primary customer identifier used in the physical 
provisioning and reporting system. It appears on every customer 
record and every call record. 

 

Term Type Termination Type  

• Swi = Switched Destination Number  

• Ded = Dedicated Destination Switch/Trunk ID 
Note: Termination Types are only applicable to certain networks. 

This field may be blanks (typically it is blank for domestic BT 

Inbound Contact). 

Term Country Country of Termination 

Note: the Term Country is function of the Term Type, when there is 

no Term Type displayed, there is no Term Country displayed either 

Term Code Terminating country code (see Appendix A for a complete list of 

country codes). 

Note: the Term Code is function of the Term Type, when there is 

no Term Type displayed, there is no Term Code displayed either 
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Svc Loc Id Service Location Identifier (customer label for termination) The 
Service location represents a switched or dedicated termination 
registered to a specific customer Corp Id.   

 

The Service location is used in logical provisioning, when defining 

routing plans, dial plans and terminating features.  All service 

locations, will have user-friendly names or ‘labels” that are 

registered in order entry. 

Destination Terminating number (phone number or SW/Tr/DNIS digits) 

DNIS Digits Dialled Number Identification Service. DNIS is only used by 

customers on the Global network with dedicated endpoints. This 

field includes the outpulsed DNIS digits  DNIS allows customers to 

specify which digits are delivered to a Dedicated Access Line 

(DAL), based on a number of factors.  

Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

  

Calls  Number of calls in the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 9. Destination Summary Monthly  

Section 1. Report Description 

 

The report lists the call results on a daily basis by Corp Id and  Destination.  

Section 2. Notes/Assumptions 

• report includes call status 

• report includes total number of call and minutes.. 

• graph contains only completed calls 

• report and graph can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 

 

Note: For optimum display of Destination graphs, select a single access number or a limited time period 

for multiple access numbers. The graph may not display properly. 

 

If the graph area is displayed with an explanation point (!), there are too many data points for proper 

display, however the graph may still be downloaded into a spreadsheet program for viewing and all of 

the data will still be included in the Data Table below the graph.  
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Input Screen  

 

• The user must select the Corp ID and click on Apply before selecting the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.   

Note: The user must select the Corp ID and hit Go before they can 

select the Access number.  

Date  

Between  

Select the date to be retrieved. 

The recorded date of the beginning and end of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 
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Output Screen 

 

Output Field - 

graph 

Description 

Y axis The number of calls.  

X axis The Destinations. 

Bar The bars are color coded to separate Completed, Released, and 

Not Completed calls.  Move the cursor over a section of the bar to 

see the number calls.  Click on the bar to display the report for that 

specific section of the bar graph.   
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Output Field- table Description 

Month The month of the call.   

Date The date of the call. (Format: DD/MMM/YYYY) 
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Corp ID  Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Term Type Termination Type  

• Swi = Switched Destination Number  

• Ded = Dedicated Destination Switch/Trunk ID 
Note: Termination Types are only applicable to certain networks. 

This field may be blank (typically it is blank for domestic BT 

Inbound Contact). 

Term Country Country of Termination 

Note: the Term Country is function of the Term Type, when there is 

no Term Type displayed, there is no Term Country displayed either 

Term Code Terminating country code (see Appendix A for a complete list of 

country codes). 

Note: the Term Code is function of the Term Type, when there is 

no Term Type displayed, there is no Term Code displayed either 

Svc Loc Id Service Location Identifier (customer label for termination) The 
Service location represents a switched or dedicated termination 
registered to a specific customer Corp Id.   

 

The Service location is used in logical provisioning, when defining 

routing plans, dial plans and terminating features.  All service 

locations, will have user-friendly names or ‘labels” that are 

registered in order entry. 

Destination Terminating number (phone number or Switch/Trunk/DNIS digits) 

DNIS Digits Dialled Number Identification Service. DNIS is only used by 
customers on the Global network with dedicated endpoints. This 
field includes the outpulsed DNIS digits. DNIS allows customers to 
specify which digits are delivered to a Dedicated Access Line 
(DAL), based on a number of factors. DNIS manages calls more 
efficiently so that when the customer advertises a specific phone 
number for a special promotion, any calls generated can be 
directed to a particular agent within the contact centre. 
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Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

  

Calls  Number of calls during the specified time period. 

Minutes The amount of time in minutes of the call during the specified time 

period. (Format: XXXX.XX) 
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Chapter 10. Call Detail Report  

Section 1. Report Description 

 

The report provides the ability to view a retrieve a report on a 7x24 basis. The report allows the user to 

retrieve information on a specific access number or all access numbers within a Corp Id for the 

requested time period and date. 

 

Section 2. Notes/Assumptions 

 

• report can be downloaded to the following formats (see Appendix B for details): 
➢ download to Excel 
➢ download to Excel 2000 
➢ download to Data 
➢ download to WebPage (MHTML) 
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Input Screen 

 

 

• The user must select the Corp ID and hit Apply before they can select the Access number. 
 

Input Field Description 

Corp ID  Select the Corp Id to be retrieved.  

Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 

Access Number Select a single Access Number, multiple Access Numbers or 

All Access Numbers “(All Column Values)” to be retrieved by 

placing a check in the box next the number(s).  

The number dialed by the caller. All caller access numbers are 

linked to an Application Id.  The caller access number must be 

recorded on the billing record.   

Note: The user must select the Corp ID and hit Go before they can 

select the Access number.  

Date   Select the date(s) to be retrieved. The date range cannot 

exceed 2 consecutive days. 
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The recorded date of the call.  

Note: Date default is MM/DD/YYYY. To select a different date 

format, go to the My Account section in Chapter 1: Introduction. 

Hours GMT  

Between 

Select the time (in GMT) to be retrieved. 

The recorded hour of the beginning and end of the call.  

Note: The default is 0 to 23 GMT Hours and 0 to 59 Minutes. 
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Output Screen 

 

 

Output Field Description 

Corp ID  Customer Corporate Identifier. The customer Corporate ID 

establishes service for a customer Corp ID is an 8-digit. The 

Corporate Id is the primary customer identifier used in the physical 

provisioning and reporting system. It appears on every customer 

record and every call record. 
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Call Result Call status on release  

Complete Call Delivered - 

Not Answered 

Includes Call Abandoned, Call not Delivered-

Busy; Call not Delivered – RTNR (Ring Tone 

No Reply); Call not Delivered - Congestion  

Released  

Call Released by Network Call queue; Call 

Released with Notification; Call Released 

without Notification; Call Limiter Blocked; Call 

Status Unknown 
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Call Result Detail Call status on release (answered, busy, abandoned, etc.) 

Comp 

Call Delivered –Only Completed Calls appear on 

Graph 

Aban Call Abandoned 

Busy Call not Delivered – Busy 

RTNR Call not Delivered – RTNR (Ring Tone No Reply) 

Ntwk Cong Call not Delivered – Congestion 

Queue Rls Call Released by Network Call Queue 

Rls w Annc Call Released with Notification 

Rls wo Annc Call Released without Notification 

Call Lim 

Blkd Call Limiter Enabled 

Unknown Call Status Unknown 

 

Orig Code Country code associated with the dialed access number (see 

Appendix A for a complete list of country codes. 

Orig Country Country code associated with the dialed access number. 

Access Type Inbound access type. 

DomTF Domestic Tollfree 

ITFS International Tollfree 

UIFN Universal International Freephone Number 

PSTN Public Switched Telephone Network/Caller Pays 

SC Shared Cost 

NCR National Call Rate 

IVRP/ 

Redirect Interactive Voice Response/Redirect 

DTF Direct Tollfree 

PRS Premium Rate Service  

TIVRP Transfer Interactive Voice Response 
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Access Number The number dialed by the caller (not necessarily the same as the Network 
Address). All caller access numbers are linked to an Application Id.   

App ID  Application Identifier. (corresponds to the dialed number). Applications 
Ids are a grouping of one or more BT Inbound Contact global access 
numbers.  All access numbers must be linked to a 10-digit application Id.  
They are assigned from within the Logical Provisioning System.. 

 

Network Address Network address where call enters BT network. 

This is typically the called party number received by the BT 

network. It may be displayed in various formats. 

Caller Number The caller’s identifying telephone number (CLI) – actual CLI or 

country code substitution (also known as ANI or A-number). When 

provided by the originating carrier, the network will deliver 

identifying number (CLI) to the call centre. BT supports CLI 

Delivery for DAL delivery only; however, it is not yet widely 

available and is subject to PTT availability and local regulatory 

restrictions.  

Term Type Termination Type  

• Swi = Switched Destination Number  

• Ded = Dedicated Destination Switch/Trunk ID 
Note: Termination Types are only applicable to certain networks. 

This field may be blanks (typically it is blank for domestic BT 

Inbound Contact). 

Term Code Terminating country code  

Note: the Term Code is function of the Term Type, when there is 

no Term Type displayed, there is no Term Code displayed either 

Term Country Country of Termination 

Note: the Term Country is function of the Term Type, when there is 

no Term Type displayed, there is no Term Country displayed either 

Svc Loc Id Service Location Identifier (customer label for termination) The Service 
location represents a switched or dedicated termination registered to a 
specific customer Corp Id.   

 

The Service location is used in logical provisioning, when defining 

routing plans and terminating features.  All service locations, will 

have user-friendly names or ‘labels” that are registered in order 

entry. 

Destination Terminating number (phone number or Switch/Trunk/DNIS digits) 

DNIS Digits Dialled Number Identification Service. DNIS is only used by 

customers on the Global network with dedicated destinations. This 

field includes the outpulsed DNIS digits. DNIS allows customers to 
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specify which digits are delivered to a Dedicated Access Line 

(DAL), based on a number of factors.  

Call Start Date The date of the beginning of the call. 

Call Start Time  The time (in GMT) of the beginning of the call. (Format: 

HH:MM:SS). 

Call Answer Time Time when call is answered (Format HH:MM:SS) 

Call Disconnect 

Time 

Time when call is disconnected (Format HH:MM:SS) 

Call Duration 

Minutes 

Duration Minutes. The amount of time in minutes of the call. 

Note 1: the connection time to an announcement because of a 

feature (e.g. Queue, Menu Routing) is not included in the call 

duration. 

Note 2: the seconds are displayed as a fraction of a minute i.e. 38 

sec will be displayed as 38/60th of a minute, that is 0.63 min 

Scr Allowed/Scr 

Barred 

Screening has finished. Call is barred (CLI or A-number screening) 

Note: The Scr Allowed and Scr Barred should be interpreted 

together: 

• SCR Allowed = N, SCR Barred = N means that screening was 
not performed on this call. 

• SCR Allowed = Y, SCR Barred = N means that screening was 
performed on this call, and the call was allowed. 

• SCR Allowed = N, SCR Barred = Y means that screening was 

performed on this call, and the call was barred. 

Payphone Call using payphone (Y or N). Based on calling party category 

which is not always available. 

Call Queued Call was queued using the Network Queue feature. . 

Digits Received Concatenation of all digits entered by the caller during the call, 

when the user was prompted to enter a digit e.g. if the caller hears 

two successive invitations to enter a menu routing digit and the 

caller enters 2 then 4, “2:4” will be found in this field. 

Note:  After a caller enters an Authorization Code, they must enter 

# to indicate all digits have been entered.  This # is not displayed in 

the Digit Received field.   

Revenue Owner Revenue owner code numeric value (3 digit). A revenue owner is an 
entity or organization that has a direct relationship with BT and the 
customer to sell services within specific geographical areas.  

Overflow Count The number of Overflow attempts 
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Chapter 11. Downloading Reports 
All reports and graphs can be downloaded to another format. The following formats are supported. 

 

• PDF 

• Excel 

• Powerpoint 

• Web Archive 

• Data (CSV Format, Tab delimited Format, XML Format) 
 

 

 

 

• Select Export at the bottom of the screen. 
 

 

• Select the Export Format at the bottom of the screen. 
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70 
 

Chapter 12.  Circuit Utilisation Report 
 

A utilisation report is a summary by hour estimating the load on a destination based on the number of 

call minutes received during that hour. It can be used to identify Dedicated Access Lines that are 

overloaded or need overflow implemented as well as under-utilized circuits. It can also be used to scope 

IVR port utilisation into the IVR. Just substitute the number of ports for the number of channels when 

directed. 

 

The report described in this document is a very basic report that is most accurate when there is a high 

volume of traffic that is well distributed through the hour, which describes most call center applications.  

 

It is less accurate for customers with: 

 

• Low traffic volumes 

• Bursty Traffic (eg a call center receiving large volumes of calls in response to TV advertisements 
or televoting) 

• Conferencing applications which tend to have very high call durations and high call volumes at 
the top of an hour 

 

 More sophisticated after-market tools have been created for erlang analysis purposes. The raw data 

exported from TRS is well suited to alternative methods of presentation, including graphs or import into 

an analysis tool. 

 

Base Requirements:  

• Active account in Call Traffic Reporter with Access to "Destination Summary" reports 

• PC with Microsoft Excel or comparable spreadsheet program  

• Knowledge of the customer application, especially  
o The terminating country of the circuit 
o The terminating sw/tr Id associated with the circuit 
o The number of channels associated with the circuit / application being analyzed 

 

Note that these instructions and screenshots were created using the TRS test platform and Microsoft 

Excel for Office 2007. 
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Steps for Creating a Utilisation Report: 

 

Step 1:  

Select a report for downloading. The report used for Utilisation report generation is the "Destination 

Summary – Daily" report, which is found by clicking on the "Destination Summary" tab at the top of the 

screen. 

 

 

 

Step 2: 

First select the Corp Id of the customer being analyzed and then the corresponding time period. 
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Step 3: 

Download the data by clicking on the "Download" link at the bottom of each screen (the whole report will 

be downloaded, not just what is on display). 

 

Select the "Download Data" option, not the "Download to Excel" option.  

(The "Download to Excel" option preserves the report form at as seen on the screen. It is very useful for 

distributing the report as-is to non-users. Since the data will be analyzed for utilisation, the more raw 

data is needed). 

 

You can "Open" the report to begin editing it immediately or "Save" it elsewhere on your PC for later 

analysis. 
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Step 4: 

When you're ready to create the utilisation report, open the downloaded report. It should look like this: 

 

 

 

The fields on the this report are: 

Date: GMT Date of Calls 

Hour: GMT Hour of Calls 

Corp Id: 8 Digit Identifier associated with the customer 

Term Type:  

 DED = Dedicated Access Line terminated calls 

 SWI = Calls terminated over the PSTN 

Term Country: Country where the call was terminated 

Svc Loc Id: Logical identifier (Starts with an "F") associated with the termination of the call 
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Destination: For calls terminating at a DAL, this field contains the Sw/Tr + DNIS digits associated with 

the call’s actual termination. For calls terminating to a Switched Termination (SWI), this field contains the 

Terminating Phone Number.  

DNIS Digits: Digits outpulsed with the call, used by the customer's ACD equipment to identify the call 

and route it to the appropriate information. 

Call Result: Outcome of the Call, possible options are: 

 Comp = Completed, Answered Call 

 Ntwk Cong = Network Congestion 

 Busy = Busy Received 

 RTNR = Ring Tone No Reply (Unanswered Call) 

 Aban = Abandoned Call 

Calls: Number of calls received in that hour for that destination and call result 

Minutes: Duration of calls received in that hour for that destination and call result 
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Step 5: 

The next step is to filter out only the lines needed to create the utilisation report. 

To create a filter, first select the top row of the report by clicking on the row number (in this example the 

"1") on the far right-hand side of the screen use the "Data" menu, then select "Auto Filter" as shown 

below: 

In Excel 2007, click on the “Data” tab and then click on the “Filter” button for the same results. 
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Once the Filter has been created use the arrows on the first row to filter by: 

Termination Type = DED 

Terminating Country 

Outcome = Comp 

Only completed, answered calls contribute to a utilisation report because they are the only calls that 

could possibly occupy customer channels for a measurable duration. 

 

Filer by Type:   

 

Filter by Termination Country:   

 

Filter by Call Outcome:  
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Step 6: 

The next step is to create the utilisation formula at the end of each line. 

 

Your spreadsheet should now look like this: 

 

 

After the last column, in Row 1, create a label for the column, eg "Util %" 

 

Then in the field directly below the new label, create the following formula: 

=L3/(60*30) followed by the <Enter> key. 

(# of minutes divided by the number of minutes in an hour multiplied by the number of channels) 

In this example: 

"30" = number of channels and  

"L3" = the cell containing the minutes to be analyzed. 

Select the Cell containing the formula and select "Copy" from the "Edit" menu or press "Ctrl+C". Then 

using the mouse select all of the rows to be populated with the formula and select "Paste" from the "Edit" 

menu or press "Ctrl+V". Excel will automatically update the formula for each row. 
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Now format the column it is displayed in percentage format by clicking on the column's letter (in this case 

"M") and then selecting "Cells" from the "Format" menu at the top of the screen. Select "Percentage" 

from the "Number" Tab as shown below. 

 

 

 

The report should now be complete and look like this: 
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The next step is to convert the Destination into the circuit switch/trunk identifier (7 digits) that 

corresponds to the access line being analyzed for utilisation. The report contains a “Destination” field 

that currently consists of the Switch Id (3 digits) + Trunk Id (4 Digits) + DNIS Digits. The “Text-to-

Columns” function will trim off the DNIS digits and leave the switch/trunk. 

 

First, select the column labeled “Destination.” Some users prefer to use the “Svc Loc Id – Service 

Location Id” column for a cleaner report. Click on the “Data” menu at the top of the screen and select 

“Text to Columns”. A dialog window will pop up (the same window is present in Excel versions 2003 and 

2007). Select “Fixed Width” and then click on “Next”: 

 

 

 

In the dialog box, click to create a line 7 characters from the left to isolate the switch/trunk Identifier: 
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Click on the “Next” button to continue. Click on the 2nd column created and then the “Do not import 

column (skip)” radio button at the top right of the screen. This means that the Destination column will be 

replaced by the switch/trunk value, but not the DNIS digits. If you forget this step, you will replace the 

“DNIS Digits” column with the values in the second column created by the delimiting function, which will 

not impact the utilisation report. 

 

 

 

Click “Finish” to complete the action, resulting in only the Switch/Trunk Id being present in the field 

“Destination”, which has also been truncated to “Destina.” 
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At this point you are ready to create a utilisation summary report using a quick method using the built-in 

“Subtotals” or a more detailed Pivot Table version. 
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Utilisation Report Creation – Quick Subtotal Method 

This method uses Excel’s built-in “Subtotals” function to quickly add up and provide a utilisation estimate. 

You can use this method to quickly identify any particularly busy or circuit.  

Subtotal Method Step S1: 

Once you have isolated the terminating switch/trunk Id and have entered in the formula as shown above, 

you can then use the “Subtotal” function to display the utilisation estimate summarized by switch / trunk 

and by hour. 

Using the Filter function again, select an individual switch/trunk to be analyzed and then go the Data 

menu.  

 

 

Click on the upper right-most cell of the table and then click the “Subtotals” button (or select “Subtotals” 

from the menu) to bring up the Subtotals dialog box: 
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Because you have isolated the data to a single switch/trunk, you can then perform the subtotals on each 

hour to see the summary by hour. (Note: some users prefer to apply subtotals by day rather than hour) 

 

Click on the drop-down by the “At each change in” and select “Hours” to filter by the hour. Then click on 

the “Calls, Minutes and Util%” tick boxes under the “Add subtotal to:” option.  

 

The other fields can be turned off or on as desired and do not have an impact on the results: 
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The rows highlighted in bold show the summary for the hour. In this example, during the 1000 GMT hour, 

the 30 channel DAL associated with switch/trunk 771/8156 was approximately 6% in use.  

 

To perform the same function on a different access line, click on the “Subtotals” button again and then 

on “Remove Subtotals” to start over. 
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This allows users to view utilisation estimates at a glance. 
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Utilisation Report Creation – Pivot Table Method 

This method uses Excel’s built-in “Pivot Tables” function to provide a more reader-friendly utilisation 

estimate. It is more time-consuming than the Subtotal method above, but once mastered it is an easy 

technique that can be quickly replicated. 

 

Pivot Table Method Step S1: 

 

At this point, the user should have downloaded the table, isolated the switch/trunk using the “Text-to-

Columns” method shown above and provided the utilisation estimate in column “M”: 

 

Remove any subtotals if needed. If you haven’t already done so, save your file as an Excel workbook. 

Click on the upper left-most cell of your table. 

 

From the “Insert” menu, select “PivotTable” to begin the process: 

 

 

 

Excel should select your table as the range. Click “OK” to begin creating the pivot table. 
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You should see a screen like this in Excel 2007: 
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Drag the “Date” and “Hours” fields to the “Row Labels” section on the “Pivot Table Field List”. Then drag 

“Destina” to the “Column Labels” box. Finally drag the “Util%” to the “Values” box: 

The screen will look something like this. Users may need to change the values to view them as 

percentages. Select the values to be modified and then either click on the “%” symbol from the “Home” 

menu or you can press “Ctrl+1” on your keyboard and select “Percentages” as shown earlier. 

 

 

 

The Pivot Table will default to display “Totals” which do not actually make sense in a utilisation report as 

they total the percentages across the whole day and do not represent utilisation. If you would like to turn 

the totals off, follow these steps: 

To turn off the summarized table by date (in this case the 1/26/2012) summaries, click on the word 

“Date” in the lower right-hand corner of the screen and then select “Field Settings” 
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Then click on the word “None” in the “Subtotals & Filters” dialog and press OK. 

 

 



 

90 
 

To turn off the “Grand Totals” for the entire Pivot Table, right-click anywhere on the Pivot Table and 

select “Pivot Table Options” from the list: 

 

 

 

Then click on the “Totals & Filters” tab and uncheck the “Show grand totals for rows” and “Show grand 

totals for columns” boxes: 
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Your table should look something like this now: 
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Chapter 13. Troubleshooting 
 

IF Then 

You need your password reset  

(Passwords don’t expire, accounts gets inactive 

after 120 days of inactivity. Same passwords 

would work after the reactivation of account.) 

 

 

Contact GS Portal Helpdesk at +44 (0) 1847 

805403 or send an email to  

myaccount-help@bt.com 

 

 

  

mailto:myaccount-help@bt.com
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Chapter 14. Document History 
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